
Oracle© Enterprise Single Sign-on 
Anywhere 
Administrator Guide 
Release 11.1.1.1.0 
E15579-01  

August 2009 

 



Oracle Enterprise Single Sign-on On Anywhere Administrator Guide, Release 11.1.1.1.0 

E15579-01  

Copyright ©2009, Oracle. All rights reserved. 

The Programs (which include both the software and documentation) contain proprietary information; they are 
provided under a license agreement containing restrictions on use and disclosure and are also protected by 
copyright, patent, and other intellectual and industrial property laws. Reverse engineering, disassembly, or 
decompilation of the Programs, except to the extent required to obtain interoperability with other independently 
created software or as specified by law, is prohibited.  

The information contained in this document is subject to change without notice. If you find any problems in the 
documentation, please report them to us in writing. This document is not warranted to be error-free. Except as 
may be expressly permitted in your license agreement for these Programs, no part of these Programs may be 
reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose. 

If the Programs are delivered to the United States Government or anyone licensing or using the Programs on 
behalf of the United States Government, the following notice is applicable:  

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and technical data 
delivered to U.S. Government customers are "commercial computer software" or "commercial technical data" 
pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As 
such, use, duplication, disclosure, modification, and adaptation of the Programs, including documentation and 
technical data, shall be subject to the licensing restrictions set forth in the applicable Oracle license agreement, 
and, to the extent applicable, the additional rights set forth in FAR 52.227-19, Commercial Computer Software-
-Restricted Rights (June 1987). Oracle USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065.  

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently 
dangerous applications. It shall be the licensee's responsibility to take all appropriate fail-safe, backup, 
redundancy and other measures to ensure the safe use of such applications if the Programs are used for such 
purposes, and we disclaim liability for any damages caused by such use of the Programs.  

Oracle, JD Edwards, PeopleSoft, and Siebel are registered trademarks of Oracle Corporation and/or its 
affiliates. Other names may be trademarks of their respective owners.  

The Programs may provide links to Web sites and access to content, products, and services from third parties. 
Oracle is not responsible for the availability of, or any content provided on, third-party Web sites. You bear all 
risks associated with the use of such content. If you choose to purchase any products or services from a third 
party, the relationship is directly between you and the third party. Oracle is not responsible for: (a) the quality of 
third-party products or services; or (b) fulfilling any of the terms of the agreement with the third party, 
including delivery of products or services and warranty obligations related to purchased products or services. 
Oracle is not responsible for any loss or damage of any sort that you may incur from dealing with any third 
party.  

  



ESSO-Anywhere Administrator Guide 

Table of Contents 

Abbreviations and Terminology ......................................................................... 2 
About Oracle Enterprise Single Sign-on On Anywhere ........................................... 3 
Overview of Creating a Deployment Package ....................................................... 4 
General Tab ................................................................................................... 6 
Options Tab ................................................................................................... 7 

Install ...................................................................................................... 7 
Updates ................................................................................................... 8 
Agent Settings .......................................................................................... 8 

Generate Tab ................................................................................................. 9 
 

Page 1 



ESSO-Anywhere Administrator Guide 

Abbreviations and Terminology 

Following is a list of commonly-used abbreviations and terminology. 

 

Abbreviation or Terminology Full Name 

Administrative Console ESSO-LM Administrative Console 

Agent Logon Manager 

FTU First Time Use Wizard 

ESSO-AM Oracle Enterprise Single Sign-on Authentication Manager 

ESSO-Anywhere Oracle Enterprise Single Sign-on On Anywhere 

ESSO-PG Oracle Enterprise Single Sign-on Provisioning Gateway 

ESSO-KM Oracle Enterprise Single Sign-on Kiosk Manager 

ESSO-LM Oracle Enterprise Single Sign-on Logon Manager 

ESSO-PR Oracle Enterprise Single Sign-on Password Reset 
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About Oracle Enterprise Single Sign-on On Anywhere 

About Oracle Enterprise Single Sign-on On Anywhere 

Oracle Enterprise Single Sign-on On Anywhere (ESSO-Anywhere) is the latest innovation in 
portable single sign-on (SSO) technology, enabling deployment of Oracle Enterprise Single 
Sign-on Logon Manager (ESSO-LM) and other Agents to end users' desktops.  

Using the ESSO-Anywhere Console, the administrator creates a deployment package 
configured with the Oracle products needed by users of an enterprise, making the package 
available over a Web server or file share. Users download this deployment package from an 
HTML interface that is included with the ESSO-Anywhere package, and which the 
administrator customizes. Users can then perform installations of the Oracle product suite 
on their own workstations at the click of a button, with assurance that configurations are 
correct and ready to run, and without administrator intervention. 

Note:  ESSO-Anywhere is designed for compatibility with Windows Authenticator v1. It is not 
designed to work with ESSO-LM features that require installing system services or GINAs, 
adding registry entries outside of Live HKLM\Software\Passlogix, or additions to Program 
Files or Windows system folders.  

The deployment package must include ESSO-LM and might include either or both of the 
following Agents: 

• Oracle Enterprise Single Sign-on Authentication Manager (ESSO-AM)  

• Oracle Enterprise Single Sign-on Provisioning Gateway (ESSO-PG). 

The Visual C++ Runtime Library and .NET 2.0 Framework are prerequisites for running 
ESSO-Anywhere. The installation package includes the Visual C++ Runtime Library, 
however you must make the .NET 2.0 Framework available to users. See the ESSO-
Anywhere Release Notes for a complete list of software and hardware requirements. 

Note:  The final output of the deployment package is not an .MSI file. You must ensure that you 

supply any additional requirements that your end users will need to run their ESSO-LM 
and additional Agent software. 
 
Due to security restrictions in Vista, you must change group policy settings in order for 
end users running Vista client to use the ESSO-Anywhere deployment package. See the 
Technical Notes section in ESSO-Anywhere Release Notes for more information.  
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Overview of Creating a Deployment Package 

Following is the general procedure for creating a deployment package. Use the settings in 
the three tabs of the ESSO-Anywhere Console for your deployment configurations. See the 
help topic for each tab for an in-depth discussion of that tab's settings. 

To create a deployment package: 

1. Create a certificate file to be submitted when you generate the deployment 
package. 

2. Install the ESSO-LM Administrative Console and Agent on a clean workstation. 

3. Optionally, install additional Agents: ESSO-AM, and ESSO-PG.  

4. Configure all Oracle products as you want them for deployment. 

5. Make your ESSO-LM, ESSO-AM, and ESSO-PG configuration settings available to 
ESSO-Anywhere by doing one of the following: 

• To have ESSO-Anywhere import configuration settings from the local 
registry, write the Global Agent Settings to the registry;  

• To have ESSO-Anywhere import configuration settings stored in a .REG file, 
export your settings from the ESSO-LM Administrative Console to a .REG 
file. For more information, see the  ESSO-LM Administrative Console Help 
file. 

Note:  Test your configuration before proceeding to create the deployment package. 

6. Install the ESSO-Anywhere Console. ESSO-Anywhere reads the Oracle software 
configuration on the workstation where you installed it. 

7. Verify in the General tab that the products and versions installed are the ones that 
you want to deploy. 

8. From the Options tab, specify: 

• The deployment version and location, the installation location, and the 
installation type 

• The update schedule preferences 

• Which registry settings ESSO-Anywhere will use (the settings from the 
live registry, or the registry file you optionally created previously). 

9. On the Generate tab: 

The ESSO-Anywhere Console creates a deployment package in the location you 
specified in the Output folder setting. 
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Overview of Creating a Deployment Package 

• In the Summary window, review all settings. 

• Enter the directory path where the deployment package will be created, or 
click the Browse… button to navigate to the directory. 

• Click the Generate button. 

• At the prompt, enter the location for the certificate file that you created, 
and the password. 

10. From the File menu, click Save or Save As… to save the deployment configuration 
settings. 

11. Copy the deployment package to the virtual directory or file share that you 
specified in the Target location setting. 

12. If deploying from a web server, customize the index.html file in the deployment 
directory, replacing the generic text with the information that you want end users 
to see. 

13. If this is a first installation, notify users that the deployment package is available. 

14. To create additional deployment packages, reconfigure settings on the ESSO-LM 
Administrative Console, and click New on the ESSO-Anywhere File menu. 

Note:  Users do not have the option to alter the installation. If you want different users to install 

different packages, create a separate deployment package for each installation. 
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General Tab 

The two sections of the General tab contain information about the Oracle products 
installed on the workstation where you are creating the deployment package. 

 

 

Installed 
products 

This section lists all Oracle products in the configuration. This list must contain 
ESSO-LM and might also include a combination of ESSO-AM and ESSO-PG. 

File version This section lists all components that were installed as part of the Oracle product 
installation, with their version numbers and installation locations. This 
information is the same as the information in the ESSO-LM "About" box. 
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Options Tab 

Options Tab 

Use the Options tab to configure the settings for your deployment package. 

 

Install 

Use the settings in the Install group to configure the deployment version and file 
locations. 

Deployment 
version 

Specify the four-field (x.x.x.x) version number of the deployment. It is your 
choice whether to match the deployment version to the version of ESSO-LM 
that you use for the deployment.  

Deployment 
type 

Specify whether ESSO-Anywhere will install on the local workstation. 

The Install Locally option creates a shortcut icon to ESSO-Anywhere in the 
user's Start menu and adds an entry for ESSO-Anywhere to the user's Add or 
Remove Programs applet on the Control Panel.  

The Online option is a per-session deployment and does not create the Start 
menu shortcut or add an entry to Add or Remove Programs. It also requires the 
user to have access to the web server or file share where the ESSO-Anywhere 
deployment package is located in order to run ESSO-Anywhere. The files will be 
cached on the user's machine, but the user cannot run the program directly. 

Target 
location 

Enter the virtual directory or file share from which ESSO-Anywhere will be 
distributed. 
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Updates 

Use the settings in the  Updates group to specify when ESSO-Anywhere should check for 
updates, and whether the user has the option to reject them when they are available. 

Note:  If the user declines an optional update, ESSO-Anywhere does not offer that update 

again. 

Check before 
the application 
starts 

Check this box to have ESSO-Anywhere check for updates to any of the 
installed files before the application launches. ESSO-Anywhere updates only 
files that have changed. 

Check at 
defined 
intervals 

Check this box to specify a time interval at which ESSO-Anywhere checks for 
updates. Configurable intervals are from one hour to one year (52 weeks). 

Specify a 
minimum 
required 
version 

Check this box to enforce a minimum deployment version. 

Note: This setting is useful for rollbacks. ESSO-Anywhere rolls back only one 
version. If you want to roll back beyond the previous deployment, rename the 
desired rollback to a higher version than currently installed, and specify this 
new version as the minimum required. Rollbacks are available through Control 
Panel > Add or Remove Programs > Change > Restore. 

 

Localized Deployments 

In order for localized installers and update notifications to appear in the correct language, 
you must have the appropriate .NET language pack installed on the workstation. To install 
a .NET language pack: 

1. Log on to the local workstation. 

2. Install the latest Microsoft .NET Framework if it is not already present (version 2.0 
or above is required). 

3. Download and install the target .NET language pack for your version of the .NET 
Framework. 

4. Restart the workstation. 

5. Install ESSO-Anywhere.  
The installer appears in the target language. 

Agent Settings  

Use the settings in the Agent Settings group to specify which registry settings ESSO-
Anywhere should use. 

Live registry Select to use the same settings as in the ESSO-Anywhere live registry. 

Exported registry 
file (.REG) 

Select to use a custom registry that you created in the Administrative 
Console and exported. If you select this option, click the Browse… button to 
direct ESSO-Anywhere to the desired registry file. 
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Generate Tab 

Generate Tab 

Use the Generate tab to view a summary of your configuration settings, specify a location 
for your deployment output, and generate your deployment package. 

 

 

Summary Review the settings in the General and Options tabs. 

Output 
folder 

Enter the path of the directory where you want to generate the ESSO-Anywhere 
deployment, or click the Browse... button to navigate to the desired directory. 

Generate After you review your settings and specify the location of the deployment package, 
click the Generate button to create the ESSO-Anywhere deployment package. 

 

Note:  Before distributing the deployment package, verify that it works correctly. 

The ESSO-Anywhere installation includes a customizable index.html file. Edit this file with 
the information to direct end users to the deployment package, and distribute it. 
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